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Huntron Workstation software  

It is very helpful if you have a working knowledge of Microsoft Windows prio r to using 

Huntron Workstation.  

You are allowed to create a backup copy of the sof tware disk. Your purchase 

agreement allows for copies to be made for backup purposes only -  copying for 

distribution or resale is strictly prohibited.   

 

Installation Instructions  

Install the software BEFORE  connecting any hardware. Uninstall any previous ve rsions 

prior to loading the current version.  For more installation details follow the ñGetting 

Startedò sheet included with your Huntron product. 

 

Uninstall any previous versions of Workstation  4.3  prior to installing the new version.  

Insert the Huntron Workstation DVD. The DVD should Autorun and begin the 

installation process. If your PC has Autorun disabled the n open a browse window to 

the DVD  and select WorkstationSetup.exe. This will begin the installation process. 

During the instal l you will be asked to install additional software for Access Probers. 

Select the appropriate response based on your Prober hardware  (refer to the ñGetting 

Startedò documents supplied with the Prober). 

If you purchased CAD Tools then install using the supp lied CD. Follow instructions 

listed in the CAD Tools Tutorial.  

If you are using Workstation in conjunction with a digital multimeter, follow the 

instruction s listed in the Workstation DMM Tutorial.  

All of the Workstation tutorials are available on the Hunt ron web site:  

www.huntron.com/sales -support/software.htm  

 

 

http://www.huntron.com/sales-support/software.htm
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Huntron Workstation Main Interface  

When starting Huntron Workstation for the first time, you will be prompted for an 

activation co de. Type in the code exactly as it is presented on the installation CD.  

Huntron Workstation 4  has built - in conversion utilities that enable convers ion of board 

tests created in 3.X versions of Huntron Workstation.  

 

 

The Main Wi ndow for Huntron Workstation 4  features a multi -pane layout so many 

aspects of the test creation and execution can be displayed at the same time. The 

Panes are interactive to a certain degree in that changes in one Pane will affect other 

Panes. The Panes can be resized, floated indepen dently or ñtabbedò to the sides of the 

window.  The Status Bar displays information about items currently selected and status 

information while processes are running.  

 

 

 

 

 

 

 

 

Tree Pane  
-  Test and editing  

Signature  Pane  
-  Signature display 
and scanning  

Prober  Pane  
-  Robotic Prober 
control  

Image  Pane  
-  Display of CAD 
layout and PCB 
images  

Status bar  

Tool bars  
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The Toolbar  

The Toolbar just under the application menus allows for quick access to several 

program functions. The function of each is broken out in the diagram below.  

 

 

 1.  2.  3.  4.  5.  6.  7.   8.   9.  10.   11.  12.  13.  14.  15.  16.  17.  18.  19 . 

 

1.  Create New Board database  11.  Scan Component or Net  

2.  Open Board database  12.  Scan Sequence  

3.  Save Asé 13.  Send Prober  head to  Home  position  

4.  Add New (Sequence, Component  or Range)  14.  Connect/Disconnect Prober  

5.  Copy (Sequence, Component, Net  or Range )  15. Connect/Disconnect Tracker  

6.  Paste (Sequence, Component , Net or Range)  16 . Previous Component or Net  

7.  Cut (Sequence, Component , Net or Range)  17 . Next Component or Net   

8.  Delete (Seq ., Comp., Net, Range or Scan)  18 . Previous  Pin 

9.  Build New (Sequence, Component)  19 . Next Pin  

10.  Repeat New  (Sequence, Component)  

 

Hardware Setup  

 

 

When first starting Huntron Workstation, select Options  from the Tools menu. The 

Options window is used to setup default settings used when working in Huntron 
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Workstation. Select the General  tab and set the desire d Unit of Measure (use Microns  

for Huntron Access Probers, Mils  for any other Prober).  

For this tutorial, the Huntron Tracker 3200S, Tracker Model 30, ProTrack and 

TrackerPXI  will be referred to in general as ñTrackersò. Specific models will be 

mentioned by name if certain software features apply a specific Tracker model. The 

ProTrack Scanner, Scanner II and Scanner 31S will be referred to as ñScannersò. 

Specific models will b e mentioned by name if certain software features apply a specific 

Scanner model.  

 

 

 

Select Options  from the T ools menu. Select the Hardware  tab and set the type of 

Tracker  hardware that is connected to the PC , the Tracker Port ( USB) and Scanner (if 

connec ted; Scanner II users should also select the number of Scanners connected in 

the ñScannersò drop menu).  Access  Probers with Tracker  (built - in) should select 

ñAccess Tracker ò in the Tracker menu. 

 

Prober users will need to select the type of Prober, the ser ial port for the Prober and 

the Frame Grabber type. To determine which COM port the Access USB (for Access 

USB Probers only) connection is using, click the Find button for Workstation to detect 

the Prober port. If this does not work, go to the Windows Cont rol Panel , select 

System  and select Device Manager . Locate the Ports settings as shown in the image 

below. Use the COM number shown next to ñHS-20USBò.   
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Check the Enable NI Vision Auto - Align  checkbox if you wish to enable the 

automatic alignment process that uses the National Instruments Vision Runtime. This 

option will function only if the NI Vision Runtime has been installed from an earlier 

Workstation installation (version 4.3.6361 and bef ore). Leave this checkbox 

unchecked  to use the new built - in Auto -Align function . 

Click the Connect  buttons  to initiate communication with the selected hardw are. Once 

connected, click the Save (Permanent)  button to save this configuration as the 

startup def ault.  For initial installation using a ProTrack, you will see a message that 

Loop Compensation was not found. A Loop Compensation file will need to be created.  

 

Using a ProTrack  

If a Loop Compensation (Loop Calc) file does not exist for the selected config uration, a 

message will appear asking that  Loop Calc be performed with  ProTrack Diagnostics.  
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Loop Calc needs to be run before you can use a NEW installation of the 

Huntron Workstation software  with a Huntron ProTrack .  

-  Select Tools/Maintenance/ProTrack Diagnostics  from the menu  

Run a diagnostic routine by clicking the appropriate button in the ProTrack I 

Diagnostics window. Clicking Loop Calc  will execute the Hardware Check (except 

Scanner Test ) before running th e Loop Calc routine. The Loop Calc takes 

approximately 20 minutes to complete. Once complete, a Loop Compensation file is 

created for the selected hardware configuration.  You will also be prompted to save a 

ProTrack configuration or ñ.PTCò file (the name will be the serial number you entered 

in t he Diagnostics window). Click Yes  to save the PTC file to your PC. With newer 

ProTrack units (serial number prefix KJ3 or KJ4), you will be prompted by another 

window displaying ñDownload the LoopCalc settings into the ProTrack for manual 

control?ò Click Yes to download the settings. Exit Diagnostics and select 

Tools/Options/Hardware  and reinitialize the hardware by clicking the 

Connect/Disconnect buttons.  

Other functions in the ProTrack Diagnostics allow for reading or writing the ProTrack 

configuration fi le. The Read from ProTrack  button will retrieve calibration and user 

settings from the ProTrack I unit and store them as a text file on the connected 

computer  in the Program Files/Huntron/Hardware folder . It is recommended this be 

performed when setting up  the system for the first time or after making changes to 

the ProTrack such as the addition of customs ranges and range groups. The file 

generated should be stored in a safe location.  

The Write to ProTrack  button will send the calibration and user informat ion to the 

ProTrack I unit. This can be performed if it suspected that the information stored in the 

FLASH memory of the ProTrack I has been corrupted.  
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Using a Tracker 3200S  

The Tracker 3200S comes from the Factory calibrated for standalone use. If the 

Tracker 3200S is connected to a Prober, Scanner or other cabling, calibration must be 

performed.  

-  Select Tools/Maintenance/ Tracker 3200S  Diagnostics  from the menu . 

Click the  Alignment  button  the Tracker 3200S  Diagnostics window. When the 

Calibrate procedure finishes (about 10 minutes), run Verify Alignment . This also 

takes about 10 minutes to complete. The Calibration information is stored in the 

Tracker 3200S and will be used by the software. If changes are made to the cabling or  

attached instruments, simply run Calibrate and Verify Calibration again.  

 

Using a Tracker Model 30  

The Tracker Model 30 comes from the Factory calibrated for standalone use. If the 

Tracker Model 30 is connected to a Prober, Scanner or other cabling, calib ration must 

be performed. Access Probers with Tracker  inside come from the factory with the 

calibration already completed.  

-  Select Tools/Maintenance/ Tracker Model 30  Diagnostics  from the menu . 

Click the  Alignment  button  the Tracker Model 30  Diagnostics wi ndow. When the 

Calibrate procedure finishes (about 10 minutes), run Verify Alignment . This also 

takes about 10 minutes to complete. The Calibration information is stored in the 

Tracker Model 30 and will be used by the software. If changes are made to the cabling 

or attached instruments, simply run Calibrate and Verify Calibration again.  

 

Manual Modes ï Tracker and Scanner  

     

You may find it useful to manually test some of your components while adjusting the 

range parameters. The two man ual modes, Track er and Scanner located in the 

Signatures  pane, can work together to display the signature of a component pin.  
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Tracker mode sets the range parameters, cha nnel and tolerance. You can also  set the 

Pulse Generator settings  (Tracker 3200S and ProTrack only) and  use ALT  mode to run 

channel A versus channel B comparisons . Signatures will be displayed to the right 

while probing with hand -held probes  (select the Real - time check box) . The Hold  

button will capture and hold t he current signature allowing for  quick comp arisons.  

Scanner m ode allows you to use a Huntron  Scanner to interface to the component 

pins. You can set the package type, number of pins and common pins. The Scan  

button starts a hands free scan of the component or you manually increment the pins 

with th e <<  and >>  buttons. The Hold  button will capture and hold t he current 

signature allowing for  quick comparisons.  To store signatures you will need to create a 

Board Test .  NOTE: Users w ith Access Probers with Tracker  inside should select 

Channel B  when using Manual mode.  

  

Creating a Board Test  

There are a number of steps necessary to creating a board test.  

 

Workstation Tree Structure  

-  Board (created Huntron Workstation (.hwdb) database file)  

-  Sequence (Test set  of Components)  

-  Component or Net (name)  

o Pins (name, channel)  

o Ranges (V, F, R range settings)  

 

Example of Board Test Information :  

Board Name: Mai n Board (creates ñmain board.hwdbò file) 

 Revision: Rev. A (This field is optional)  

Sequence: ICôs  

Component: U27 (component name) or A2 (NET name)  

Pins: per pin settings for Scan Pin setting, channel, net name, etcé 

Ranges: Per pin settings for common reference pin, tolerance, etcé 

The user has total discretion as to the information input into these fields. There  is no 

ñrightò way as to what information is entered as every userôs situation will be different. 

The above example is just one way the information might be entered.  
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Entering information into the Entry windows is very straight forward. The easiest way 

to m ove from field to field is by pressing the TAB  key. You can also use the mouse to 

click into a particular field so you can enter information.  

 

Converting a Test Created in Workstation 4.2  

Workstation 4.3 uses a different database type than version 4.2. To update a version 

4.2 test to work in version 4.3, select Open  from the File  menu. In t he Open window, 

select .MDB  from the file type drop menu. Select the .MDB test file name and click the  

Open  button.   

Note: Select .HBK  if you are converting Workstation version 3.X backup files.  

 

 

Click the Convert  button to create the new test for version 4.3. The conversion can 

take some time based on the original test size.  
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Click the Close  button when the conversion is complete. The updated test will be 

opene d in the Workstation interface.  

 

Huntron Convert MDB Application  

As an alternative, the conversion process can be run externally by browsing to the 

Program Files (or Program Files (x86) ) \ Huntron Workstation 4.3 folder and double -

click ing  the HuntronConvertMDB.exe  application. This application allows you to 

select a n .MDB file created in version 4.2 and convert it to the 4.3 database format.  
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Use the MDB Database field  to select the version 4.2 test database you want to 

convert.  

Use the HWDB database field  to select the path and name for the new 4.3 database.  

Use the Template HWDB Data field  to select the preinstalled Template database. 

Use the same information as displ ayed in the image above . 

Use the Log File  field  to select the path and name for the application log file . 

Leave the Gold Disk Number field  blank unless you are converting tests used in the 

US Navy Gold Disk program.  

Click the Convert  button to start the co nversion. You will see a pop -up dialog when 

the conversion is complete.  

 

Test Building Procedures  

-  Create Test Database in the Tree Pane  

o Add Board, Sequence, and Components before teaching or scanning  

-  Scan Components and Set References (Tracker only or Trac ker/Scanner users)  

-  Perform Camera Offset (Tracker /Probers users)  

-  Select Alignment points (Tracker/Prober users)  

-  Teach component pin locations (Tracker/Prober users ï teaching all points 

before scanning will save you time)  

-  Scan Sequences and Set References  

 

Listed above is a general outline on how you would proceed when preparing to test a 

board. These guidelines apply to all package types and boards. As with any type of 

complex test equipment, practice makes perfect so take the time to learn  and practice 

these procedures.  
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Creating a Board Database  

 

 

To create a new Board, select New  from the File menu or use the New button in the 

toolbar. Input information into the ñAdd New Boardò dialog as needed. The only field 

that is required is board Name . Other fields such as Revision, System, Unit, 

Manufacturer and Gold Disk Number can be completed with related information  if 

desired .  

Access Prober users should select their desired Units of Measure . This controls which 

units (mils, inches, microns, o r millimeters) are used in the Prober movement controls.   
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Add ing a  New Sequence  

 

 

To add a new Sequence, select the Sequence  tab in the Tree pane. Select Add New 

Sequence  from the Edit menu or click the Add New button (+)  in the toolbar.  

Details:  

Sequence Name  Field: Enter Sequence name  

Slot  field (Prober users): Select the Prober slot that the board will be mounted in to  

when scanning.  Select from TOP, MIDDLE, BOTTOM or BASE (Access 2, Access DH).  

Compare Priority : Selects the comparison priority b etween Same  (serial number), 

All  (serial numbers ; this is the recommended setting ) or Merge  (Merged min/max 

signatures)  

Instructions field : Enter any instructions or system information that you wish to 

pass on to future users.  

The Delete  Scans  button will erase all scans stored under the  Sequence.  

NOTE:  Access DH users should select the Testers  tab and check the ñEnable Access 

DHò checkbox . 

Buttonsé button adds a new user configured Toolbar button. See the Buttons section 

at the end of this tut orial.  

NOTE:  You can set your Sequence defaults using the Tools 

menu/Options/Sequence tab . Access DH users should make sure the ñEnable 

Access DH ò checkbox is checked.  

 

Other functions within this window can be read about by clicking the HELP  button.  
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Component Package Types  

 

There are four different package types you will find yourself using when  creating 

components used in a Prober  test sequence.  The XY locations for each package type 

are ñtaughtò in slightly different ways. They are DIP  (dual - in - line), SIP  (single - in -

line), PROBE  (point by point), and MULTI  (multiple row or si ded).  

 

For Tracker  with Scanner users, the package type determines how the Scanner pins 

are counted. The available Scanner packages are DIP , SIP , Both , Front , SIP2X  

(combines the A and B channels for 128 pins) and DIP2X  (combines the A and B 

channels for 128 pins). Users of the Scanner II accessory have a DIPII  and SIPII  

package available allowing them to daisy -chain Scanners together to achieve up to 

1024 pins.  

Users of Probers and  Scanners have a MULTI - SIP  package that l ets them to probe a 

component as MULTI  package while the Scanner counts through the front connector 

as a SIP  package. This allows for selection of Common references through the 

Scanner to the Prober mounted board -under - test using a custom cable.  

 

Prober  users will use the DIP, 

SIP, MULTI and PROBE 

packages.  

Tracker with Scanner  users 

will use DIP  (including DIP2X) , 

SIP (including SIP2X), FRONT,  
BOTH, DIPII or SIPII  
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Add ing a  New Component  

 

To add a new Component, select the Component  tab in the Tree pane. Select Add 

New Component  from the Edit menu or click Add New button ( + ) in the toolbar.  

Details:  

Component Name  field: Enter the component name (reference designator) in this 

field.  

Package  and Number of Pins  field s:  Using the mouse, click on the down arrow to 

the right of the field to bring up the pull -down menu. Select the package type and 

number of pins from th ese menu s. For Access DH users  it is recommended that you 

select Number Of Pins  as 1  for 2 pin Probe package components such as resistors 

and capacitors.  

Type  field: This information is optional but you can enter the component type in this 

field.  

Pin Spac ing : For prober users, you can enter the spacing between compo nent pins in 

this field (i.e. mils, microns, mm or inches depending on Board level setting ) . This will 

be used to calculate distances between key pins when in Teach  mode.  

Connection Type : Select  the type of hardware used to interface to the component  

Open Check Type : Select from None,  Recheck or Reprobe to retest test points that 

are detected as open. Selecting Recheck will test the point with the probe lowered the 

distance set by Open Recheck De pth.  Reprobe will raise and lower the probe several 

times then retest. The number of ñreprobesò is set in the Tools/Options/Prober  tab.  
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Correction Steps : Sets the maximum amount of correction steps used with the 

Huntron Access Prober when moving to the fir st pin of the component.  

Instructions  field: Enter any instructions or component information that you wish to 

pass on to future users. Version 4.3 allows you to paste rich text format (RTF) 

information into the Instructions fi eld. This includes formatted text and images. It is 

recommended that the JPEG format be used for images to keep the database size 

under control.  

Other functions within this window can be read about by clicking the HELP  button.  

 

Tree/Pin Tab  

Once a component is added to the Workstation  Tree, switching to the Pin tab will 

display information for each pin of the selected component.  

 

Text in the Name  field can be modified directly by clicking in the text field and typing 

the new name. The Scan Pin  setting enables or disables scanning of the pin. Pause  

will cause the scan to pause when the selected pin is reached. The Channel  field 

controls which channel ( A or B ) is used. Controls for the Pulse Generator (ProTrack 

and Tracker 3200S) can also be cont rolled at the Pin level. These control include Pulse 

Type  (polarity), Pulse  (on/off), Pulse Level  (amplitude) and Duty Cycle  (up to 50% 

on pulsed signals) .  

Information on the other settings in the Pin tab is available in the Workstation Help .  
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Add ing a  New Range  

When a new component is added to a Sequence the ranges used are set by the 

defaults set up in the Tools/Options/Ranges  tab. It is best to set up your desired 

default ranges before adding Components to your Sequence.  

  

In the Range/General tab,  enable the number ranges and set the tester type as 

Tracker (default). In the Ranges tab, set the Voltage, Resistance and Frequency range 

parameters. These are the ranges that will be used when adding a new Component. It 

does not change existing Component s. On a new software ins tallation these defaults 

set three  ranges ï 3V, 50Kohms at 5 00Hz ; 3V, 1 Kohms at 200Hz  and 3V, 50 

ohms at 60Hz .  In gen eral use, these three  ranges will work well but you may need to 

add or modify ranges based on component type and value. As a general reference, the 

table below can be used to assist you in setting ranges.  

 

The Tracker signatures are shaped based on the Tracker range settings  and the 

component type/value . The basic goal is to achieve signatures that are halfway 

 

 Range 

Impedance® 

Voltage> 
200mV 

 
3V 

 
6V 

 
10V -15V 

 
20V 

 10W - 100W continuity, 
shorts, caps, 
resistors & 
inductors 

low 
impedance 

components 

newer MOS 
ICs 

power supply 
& regulators 

 

 1KW - 10KW resistive 
faults 

latest MOS & 
surface 
mount 

ICs 

newer MOS 
ICs 

older MOS ICs  

 20KW resistive 
faults 

resistive 
faults 

older MOS 
ICs 

TTL 74XXX  & 
74LSXXX ICs, 
older MOS Ics 

TTL 74XXX  
ICs, power 
transistor 

 100KW resistive 
faults 

resistive 
faults 

resistive 
faults 

resistive faults Hi resistance& 
Hi power 
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between open and short. The signatures for the four basic types of components shown 

below illustrate t his primary goal.  

 

 

 

 

 

 

 

 

 

 

To add a new Range  to the selected Component , select the Range tab in the Tree 

pane. Select Add New Range  from the Edit menu or click the Add New button ( + ) in 

the toolbar. A pop -up dialog will ask where you want the new range to be added.  

Select the desired radio button ( All Pins  is generally the desired selection) and click 

OK . 

 

Select the Tree/Range tab to display 
the ranges for the selected 
component pin. RIGHT click on the 
row header (far left grey area of the 
row) to display a quick menu (shown  

left)  

Resistance 

Capacitance 

Inductance 

Semi-conductance 
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Add New Range Details:  

Note: Voltage/Resistance/Frequency  can be modified directly in the Range grid.  

Voltage/Resistance/Frequency fields:  Select the desired ran ge settings  

Max Samples/Tolerance/Delay:  Select the setting to be used when scanning this 

range  

Common Pin :  Select Scanner common pins to be used when scanning this range . 

Scanner users wishing to use a particular component pin (i.e. ground pin) for Common  

should select the Common pin at this time using the Common Pin 1 field .  

Prober Common Pin : This allow Probers to select a Common connection  (1 -4)  

located on the front panel of the Prober.  

Note:  It is easier to set up the ranges used by selecting Tools/ Options/Range  from 

the Tools menu in the menu bar and pre - configuring the default ranges.  
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Scanning with a Tracker or Tracker with Scanner  

Users of Trackers with hand probes or Scanners can now proceed with actual scanning 

of a Sequence or Component. To scan an entire Sequence, select the Sequence in the 

Tree/Sequence tab  or enable the Sequence checkbox  in the Scan tab . To scan an 

individual component, select the component in the Tree/Component tab. Select the 

Scan tab  in the Signatures pane and input a Serial N umber  then click the Start  

button.  

 

 

 

You will be prompted to connect to the component. Tracker with Scanner users should 

connect to the selected component at this time.  Click OK  to initiate the Scan.  
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If you are performing Sequence scan you will be prompted to continue to the next 

component until all of the components in the Sequence have been scanned.  

If a Tracker with probes is being used your will prompted to connect to pin 1 of the 

selected component (if performing a single component scan ) or of the first component 

in the Sequence (if performing a Sequence scan). Click the OK  button to scan the first 

pin. You will then be prompted to move to the next pin for scanning. Click OK  to scan 

and continue in this manner until all of the component pins are scanned. At anytime 

during scanning you can click the Previous Pin  button to go back and rescan the 

previous pin.  

 

 

Once all pins are scanned click the OK  button to continue.  

When t he Sequence or Component scan is complete the Scan Results window will be 

displayed. Go to the Scan Results  section of this tutorial for more information on 

what to do after scanning.  

If the Tracker Scanner connections are being used (i.e. DIP clip and cab le) you will be 

prompted to Connect to the Component before the scan is executed. Connect the 

Scanner cable to the component to test and click OK  to start the scan. Once the scan 

is complete, the Scan results will be displayed.  
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Mounting a PCB in an Access  Prober  

Before software functions relating to an Access Prober can be performed, the PCB 

under test must be mounted into the Prober test area. Use the mounting accessories 

supplied with the Prober to securely mount your PCB  by its edges . 

 

 

 

Refer to the Access Prober Users manual for more information on mounting a PCB. In 

some cases, a PCB holder is the best solution especially when the PCB cannot be easily 

mounted using the standard accessories. PCB holders are typically simple to construct 

and the only prerequisites are that the holder fit into the Prober and that it holds the 

PCB precisely at one of the designated Prober ñSlotsò. The Slots are referred to by the 

position in the Prober as TOP, MIDDLE, BOTTOM and BASE (Access 2 and Access DH 

only)  and are  set in the Sequence Edit window (see section ñAdding a New 

Sequence ò). 

 

 


